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CHAPTER 1. SITE - SITE DATA MANAGEMENT 

The Site module is used for the interactive treatment of geographical information relative to 
sites. It allows the user to display borings and their geotechnical properties in a spatial system in 
2D and 3D in addition to a cartographic map.  
 
Site uses a Graphical User Interface (i.e. with windowing) that is compatible with Microsoft 
Windows 7, 8 and 10. Site uses the Geo, X3D and SM2 libraries created by Sobek 
Technologies Inc. for data editing, the definition of the presentation style, and viewing and 
editing graphic results. Please refer to the guides for Geo, X3D and SM2 (chapter 2 of this 
documentation) for all details. 
 
 

1.  LAUNCHING THE SITE MODULE 

Double-click on this icon to open the Site module. 
 
The connection to the database can be done directly when calling Site by entering the following 
string as target. The string will be:  
C:\Geotec80\Bin\Site.exe username/password@odbc:connection_alias  
  
See paragraph 1 of chapter 2 of the X3D guide for all the details about the connection to a 
database.  Once the connection to a database is done, the user can execute a data query to 
produce a plan or 3D view.  
 
When Site is first launched, the following files are loaded from C:\Geotec80\Style: 

• the markers file geotec8.mrk; 

• the patterns file geotec8.ptn; 

• the style file site_landscape.sty which is a classic presentation model with a plan view. 
 
The user can begin working with this initial presentation, or open another style file included with 
the software.  He can modify the style file and save it in a new presentation.  In subsequent 
loadings, Site opens the style, markers and patterns files that were in use when Site was 
closed.  
 
 

2. FILE, EDIT, INSERT, WINDOW AND HELP MENUS 

None of the options of the File, Edit, Insert, Window and Help menus is specific to Site.  The 
detailed description of each option of these menus is done in chapters 2, 3, 4 and 8 of the X3D 
guide.  
 
 

3. VIEW MENU 

The 2D View and 3D View options of the View menu and this button are used to change the 
view of the PLAN_VIEW graph. In the axes editing window, it is possible to change from 2D to 
3D view and vice-versa for PLAN_VIEW.  For the sub-graphs, the box cannot be checked.  
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The OpenGL mode is used to view solids and surfaces with hidden lines and faces and 
shadows in 3D. The XVT mode is the standard display mode.  
 
The last column (OGL) of the graph editing window (see Figure 1-2) is used only for the 
OpenGL mode in 3D. The user enters the value of the radius corresponding to the maximum 
scale for the numerical values. For example, if an OGL of 5 is entered for the SAMPLE graph 
displaying the RQD of the samples, an RQD of 100% will be 5m in OpenGL, of 20% will be 1m, 
etc. 
 
In OpenGL mode, the user can then save his data file in an .igs format to export in CATIA.  
 
 

4. TOOLS MENU 

The options of the Tools menu are used to define the utilisation parameters of Site and to edit 
the graphic components produced by Site: the characteristics of the graphic page, the graph, 
sub-graphs and their curves, the legends, the axes, the markers and patterns used.  All these 
options are described in details in chapter 6 of the X3D guide.  
 
Options is specific to Site. It is presented in paragraph 4.1.  
 
The SM2 Mode is also specific to Site. It opens the SM2 library for the site mapping and 
modeling. See chapter 2 for all the details. 
 

4.1. Options 

The Options item of the Tools menu or this button opens the window of options for data 
display, shown in Figure 1-1, where the user can define the display parameters of the borings, 
axes, limits, etc. in the plan view (and 3D view).  
 
4.1.1. Maps and domains display 

• Upon navigating, the user can choose to display only the current site or all the sites at 
once. When all the sites of a query are displayed, they are shown according to the option 
selected for the calculated domain (see below). By navigating among the records, the 
current site is shown in red.  

• The user can display the site map and/or the region map in the plan view or 3D view by 
checking the corresponding box. The site map is entered in the FILE_NAME field of the 
SITE table, must be located in the directory of the input files and of a .sit extension. The 
region map is entered in the FILE_NAME field of the REGION table, for the region 
associated to the site and must also be in the directory of the input files or have its 
complete path and be of .sit extension.  

• A scrolling list Is used to choose the basis of the calculated domain: 

o The SITE table - based on the EASTING, NORTHING, WIDTH, HEIGHT and ANGLE 
fields of the SITE table. 

o The site map - based on the site map in a .sit file (the site map must be displayed). 

o The REGION table - based on the EASTING_MIN, EASTING_MAX, NORTHING_MIN 
and NORTHING_MAX of the REGION table for the region associated to the site. 



 Site - Site Data Management 1-3 
 
 

Tools menu 2019-09-27 
 

 

o The region map - based on the region map in a .sit file for the region associated to the 
site (the region map must be displayed). 

o Borings location - the area including all the borings retrieved. This mode is particularly 
useful for the early detection of errors in the coordinates. 

o Axes location - the area including all the turning points of the axes and the associated 
profiles retrieved (for the 3D view). 

o Axes and borings location - the area including all the borings and axes retrieved. 

o Limit defined domain - the area including the polygonal limit retrieved, the one whose 
name is the same as the site retrieved, or the one that has the site retrieved as 
reference. 

o All available data - the area including all borings, axes and domains associated to the 
sites and regions and to their respective topographic maps. 

• Check the box Display domains to display the outlines of the domains specified below. 

• Check the box Detect domains to display information about the domains in a tooltip when 
the user moves the mouse on a domain outline. The domains must be displayed for this 
option to be available. 

• With the option Display file with extension, the user can display an additional topographic 
file, on top of the site map (.sit). The file displayed will be the one whose name is indicated 
in the FILE_NAME field of the SITE table, located in the input files directory, and with the 
extension selected in the scrolling list.  

 

 

Figure 1-1 - Data display options 

• The next five buttons open the drawing attributes configuration window, and correspond to 
the curves numbered #130 to #134 in the legend and curves editing window for the 
PLAN_VIEW graph (see figure 1-3). It is possible to define the attributes from both 
locations. See paragraph 8.1 for all the details. 
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o The button next to the label Calculated domain corresponds to the dom_calculated 
curve (#134), which delimits the resulting domain, calculated according to the option 
selected in the drop-down list.  

o The buttons next to the labels Site domain from database and Region domain from 
database correspond to the dom_site_db (#130) and dom_region_db (#131) curves, 
which delimit the domain of the site and of the region, as defined in the database.  

o The buttons next to the labels Site map domain and Region map domain correspond 
to the dom_site_map (#132) and dom_region_map (#133) curves, which delimit the 
site map and region map in the .sit files. 

 
4.1.2. Geotechnical data display 

• The buttons in this section open the drawing attributes configuration window, and 
correspond to the curves numbered 100 to 102, 110 and 120 in the legend and curves 
editing window for the PLAN_VIEW graph (see figure 1-3). It is possible to define the 
attributes from both locations. See paragraph 8.1 for all the details. 

o The Axis points button corresponds to the Axis_Points curve (#100) and is used to 
define the line passing through the turning points of the axes and the markers at these 
points.  

o The Axis curve button corresponds to the Axis_Curve curve (#101) and is used to 
define the curvature of the axes, their identification and their symbol for their end points. 

o The Axis profile button corresponds to the Axis_Profile curve (#102) and is used to 
define the position of the geophones and the profiles obtained. 

o The Boring button corresponds to the Boring curve (#110) and is used to define the 
identification of the borings in the plan view, their symbol and their projection.  

o The Sampling button is not used.  

o The Limit button corresponds to the Limit curve (#120) and is used to define the 
rectangular or polygonal limits. 

 
If the retrieval is done via the Axis entry form (similarly to the usage in Pro): 

• Check the box “Display only borings close to current axis” to retrieve a rectangular limit 
around the axis, of a distance specified in the following field (m). If the option ‘display all 
sites’ is selected, Site retrieves only the borings around the current axis, otherwise a very 
large number of data could be returned. In this case, the box cannot be unchecked. 

• Check the box “Within a distance to the axis of” to display only the borings located at a 
distance to the axis smaller or equal to the distance (m) indicated in the related field. 

• Check the box Display in AutoCAD mode to set the texts in geographic coordinates 
instead of millimeters, for a better compatibility of the .dxf files produced for AutoCAD. This 
box is not active if the Google map is displayed.  

• The Elevation = 0 checkbox is used solely for AutoCAD mode. The distances are then 
calculated horizontally instead of in 3 dimensions, using elevations of 0.  

• Check the box Display Google map to display the Google map in background. This box is 
not active if the AutoCAD mode is used.  
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5. DATA MENU 

The options of the Data menu are detailed in chapter 7 of the X3D guide. The options are 
mainly used to retrieve data in the tables of the Geotec database. In Site, the default retrieval 
(simple query) is done on the Site table or the Axis table. 
 
In Site, the data entry options available in the Data menu (Entry option) and with the buttons of 

the application toolbar ( ) are those of Site, Axis, Boring, Stratigraphy and 
Sample. The user first inserts the sites, followed by the axes and borings related to the sites, 
then the stratigraphy of the borings, and finally the samples from the borings.   
 
The Color Selection option is used for the cartographic maps in OpenGL mode. It is detailed in 
chapter 2.  
 
 

6. ORGANIZATION OF A GRAPHIC OUTPUT 

The definition of graphs is established and updated in the graph editing window opened by 
selecting the Graphs… option of the Tools menu or by clicking this button. More details about 
the graph editing are available in paragraph 3 of chapter 6 of the X3D guide.  Figure 1-2 shows 
the graph editing window in Site.  
 
The table in this window contains all the graphs defined in the style file used.  Each graph is 
identified by a unique number in the # column. The first graph is always Page with # 0.  This 
graph represents the graphic page and cannot be deleted.  
 
Among the graphs, there is the primary graph PLAN_VIEW whose #P cell is 0 and the sub-
graphs whose #P cell is a negative value.  
 
Site produces one type of primary graph: a plan view (PLAN_VIEW), which is graph #1. This 
graph cannot be deleted. This graph can also be put in 3 dimensions. Use the View menu to set 
the graph in 2D or 3D. A topographic background can be displayed in the plan view (in 2D and 
3D).   
 
The plan view shows the location of the borings with markers. Specific information from the 
BORING table can also be displayed under each boring point displayed. In addition, the axes 
can be displayed, markers showing their turning points and their ends. Paragraph 8.1 presents 
this graph. 
 
When the graph is in 3D, the tridimensional view shows as columns the borings and their 
properties defined as sub-graphs. Paragraph 8.2 presents this graph.  
 
For the primary graph, the Left, Width, Right, Bottom, Height and Top fields define its position 
and dimensions; the user can modify these values.  
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Figure 1-2 - Graph editing window 
 
The sub-graphs are only displayed in the 3D view: 

• The HEADER sub-graph displays the symbols and names of the borings. 

The Left, Width, Right, Bottom, Height and Top fields reflect the position and size of the 
eventual identification boxes of the borings in the 3D view. See paragraph 9.4 for the 
details.  

• The other sub-graphs show properties measured along the borings; for example, the 
stratigraphy, results of laboratory tests, results of in-situ tests such as the absorption etc. 

These sub-graphs are considered property graphs; they are displayed as columns drawn 
parallel to the axis of the borings. The number and type of the property graphs are decided 
by the user; some of these graphs have predefined displays. The content of these graphs is 
defined in the legend and curves editing window. See paragraph 9 for details. 

Each boring displayed in the 3D view will show the defined sub-graphs. 
 
 

7. OVERVIEW OF GRAPHS 

Site associates to certain graphs a display that is completely or partially predefined. These 
graphs are described in the table. The predefined curves have numbers greater or equal to 100. 
Site manages the display of these curves, but the user can still modify some of the drawing 
attributes of the curves. Paragraph 4 of chapter 6 of the X3D guide explains how to modify the 
display attributes of a curve. 
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Graph Characteristics 

PLAN_VIEW The PLAN_VIEW primary graph shows the borings and axes in a plan 
view. It has ten (10) curves automatically generated: 

• The Axis_Points curve shows the turning points of the axes 

• The Axis_Curve curve shows the curve of the axes, their 
identification and their symbol 

• The Axis_Profile curve shows the position of the geophones and the 
profiles obtained 

• The Boring curve shows the numbers and symbols of the borings 
and their projection 

• The Limit curve shows the rectangular or polygonal limits 

• The Dom_site_db curve delimits the domain of the site as defined in 
the database 

• The Dom_region_db curve delimits the domain of the region as 
defined in the database 

• The Dom_site_map curve delimits the site map in the .sit file 

• The Dom_region_map curve delimits the region map in the .sit file 

• The Dom_calculated curve delimits the domain calculated according 
to the option selected in the options window 
 

Curves showing fields from the BORING table can be added to display 
information textually under each boring point 

HEADER The HEADER sub-graph, with its Boring curve, shows the symbols of 
the borings and their numbers.  
 
The BORING table provides information about the borings retrieved, 
including their number, their type (which influences the display of their 
marker or box) and their position. 

STRATIGRAPHY Typically, the STRATIGRAPHY sub-graph shows the symbols of the 
stratigraphic horizons (CODE1 field) or the color of their material 
(MATERIAL field). 
 
The STRATIGRAPHY sub-graph has predefined curves if the field 
displayed is CODE1, DEPTH_TOP or DESCRIPTION. 

SAMPLE Often, a SAMPLE sub-graph is defined to show the RQD of the cores.  
 
Special displays exist for the numbers and the state symbols of the 
samples. 

BORING The BORING sub-graph is mainly used to display the water levels, 
defined by WATER_DEPTH and STABLE_WATER_DEPTH and their 
respective dates.  

PIEZOMETER The PIEZOMETER sub-graph shows the installations of the piezometers, 
of the observation and supply wells and the measurements of the last 
piezometric levels. 
 
This sub-graph displays the contents of the PIEZOMETER, 
PIEZOMETER_SEAL and PIEZOMETRIC_LEVEL tables. It only 
contains predefined curves. 
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Graph Characteristics 

LIMITS  The LIMITS sub-graph shows the measurements of the Atterberg limits. 
A predefined curve displays the plastic and liquid limits using their typical 
representation (vertical dashes joined by a horizontal line) and the water 
content represented by a circle. 

CONSOLIDATION The CONSOLIDATION sub-graph shows the results of consolidation 
tests.  A predefined curve displays the minimum and maximum 
preconsolidation stresses using their typical representation (vertical 
dashes joined by a horizontal line) and the probable preconsolidation 
stress represented by a down arrow. 

ROCK_JOINT A special display exists to represent jointly the type, angle and azimuth of 
the joints, or to represent the angle of the joints. 

CPTU_ZONE The CPTU_ZONE sub-graph shows the ranges of SBT zones if the #1 
curve is SBT. 9 predefined curves in the Page allow the user to define 
the colors of the 9 different ranges. 

 
 

8. THE PRIMARY GRAPH 

Site only has one primary graph: PLAN_VIEW. It is described below. If the graph is set in 3D, it 
acts as a 3D graph. It is described in paragraph 8.2. 
 

8.1. The PLAN_VIEW graph 

The PLAN_VIEW graph shows the plan view of the selected site, region or domain. It should 
always be numbered #1. The plan view displays: 

• the symbols of the borings with their identification as well as their projection, if applicable. 
The borings are displayed on the plan view if their coordinates are defined or if they are 
associated to an axis retrieved and have a chainage and an offset. 

• information from the BORING table as texts, displayed under each boring point 

• the axes retrieved with their identification next to their end points; an axe must have at least 
2 turning points.  

• a topographic background, if requested by the user. See paragraph 4.1.1.  
 
8.1.1. Predefined curves 

Figure 1-3 shows the predefined curves (#100 to #134) of the PLAN_VIEW graph. The display 
of these curves is not affected by their type.  

• For each axis, the Axis_Points curve shows:  

o markers at the turning points of the axis; these markers are different from the end points 
of the axis; 

o a line passing through the turning points of the axis; this line merges with the outline of 
the axis except in the curved sections of the axis; 

o the attributes that can be modified for the Axis_Points curve are the line and the 
marker. 

• For each axis, the Axis_Curve curve shows:  

o its outline; this line follows the eventual curves defined by a radius at turning points; 
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o its identification; the name and symbol of the axis are displayed at both ends of the axis; 
the orientation of the text shows the origin of the axis: in reading position, the origin is 
left;  

the marker used for each axis is the one in the current markers file whose name is the 
concatenation of the type and state of the axis, for example, LS_R for a realised seismic 
line. If no corresponding marker is found, the one defined for the Axis_Curve curve will 
be used. The color and dimension of the markers can always be modified.  

o the attributes that can be modified for the Axis_Curve curve are the line, the text and 
the marker (color and dimension, the symbol has no effect if there exists a marker for the 
type and state of the axis in the markers file). 

• For each axis, the Axis_Profile curve shows: 

o the location of the geophones; their location is shown by a marker; 

o the profile obtained; the thickness and color of the line can be modified by the user;  

o the attributes that can be modified for the Axis_Profile curve are the line and marker. 

• For each boring, the Boring curve shows: 

o its identification; 

o its symbol; the marker used for each boring is the one in the current markers file whose 
name is the concatenation of the type and state of the boring, for example, TP_R for a 
realized test pit. If no corresponding marker is found, the one defined for the Boring 
curve will be used. The color and dimension of the markers can always be modified. 

o the projection of the boring on the axis, if the boring is inclined (with an azimuth and a 
dip);  

this projection is a line starting at the center of the boring’s symbol, oriented according to 
its azimuth, and whose length is the projection value of the boring onto the axis; a 
marker, as a dash, is displayed at the end of the projection line. If the user does not want 
to see the marker for the projection, he will set the period of the Boring curve to anything 
other than 1.  

o the attributes that can be modified for the Boring curve are the line (for the projection 
and its dash), the text and the marker for the boring (color and dimension, the symbol 
has no effect if there exists a marker for the type and state of the boring in the markers 
file).  

• The Limit curve shows the rectangular or polygonal limits. The attributes that can be 
modified for the Limit curve are the line and the marker (for each corner of the limit). 

• The Dom_site_db curve delimits the domain of the site as defined in the database. The 
attributes that can be modified for the Dom_site_db curve are the line and the marker (for 
each corner of the domain). 

• The Dom_region_db curve delimits the domain of the region as defined in the database. 
The attributes that can be modified for the Dom_region_db curve are the line and the 
marker (for each corner of the domain). 

• The Dom_site_map curve delimits the site map in the .sit file. The attributes that can be 
modified for the Dom_site_map curve are the line and the marker (for each corner of the 
domain). 
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• The Dom_region_map curve delimits the region map in the .sit file. The attributes that can 
be modified for the Dom_region_map curve are the line and the marker (for each corner of 
the domain). 

• The Dom_calculated curve delimits the domain calculated according to the option selected 
in the options window (see paragraph 4.1.1). The attributes that can be modified for the 
Dom_calculated curve are the line and the marker (for each corner of the domain). 
 

 

Figure 1-3 - Predefined curves of the PLAN_VIEW graph  
 
8.1.2. Curves of information 

It is possible to display information textually under each boring present in the plan view, as 
illustrated in figure 1-4. 
 
In the legend and curves editing window, for the PLAN_VIEW graph, the user inserts a curve 
whose number # is 200 or more (see figure 1-3). In the scrolling list associated to the Name cell, 
the user chooses the field name of the BORING table to display. Only information from the 
BORING table can be displayed.  
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In the Series column, the user can select “Elevation” - the elevation will be calculated for the 
depth selected, or “@@” - the equivalence to the value in the EQUIVALENCE table or in the 
LIST_ENG table will be displayed, if defined.  
 
The user can modify the display format in the Title column as well as the drawing attributes for 
each curve. The information is displayed in ascending order of the curve numbers (#).  

 

Figure 1-4 - Example of textual information added in PLAN_VIEW  

 

8.2. The 3D_VIEW 

When the PLAN_VIEW is set in 3D, it shows a tridimensional view. The 3D graph has the same 
curves as the PLAN_VIEW graph, except the Boring curve. The domains are displayed at their 
smallest elevation. Note that if no elevation is found for the domain, it is displayed at Z = 0.  
 
The 3D_VIEW shows:  

• the borings according to their dip and their sub-graphs of properties as columns parallel to 
the boring; the display of the properties of the borings is managed by the sub-graphs.  

• the identifiers of the borings with their number and/or a marker characteristic of the type 
and state of the boring, or their number in a box. 

if the markers are used, each boring will have as marker the one in the markers file whose 
name is the concatenation of the type and state of the boring, for example TP_R for a 
realized test pit. If no corresponding marker is found, the one defined for the Boring curve of 
the HEADER sub-graph will be used (see paragraph 9.4). 

for boxes to be used, their dimensions in millimeters must be defined by the user for the 
HEADER sub-graph (see paragraph 9.4); the test pits and trenches have rectangular or 
square boxes; the other borings have elliptical or circular boxes.  

• the projections on a horizontal plan of the axes retrieved with their identification next to their 
ends; an axis must have at least 2 turning points. 

• the profiles of the stratigraphic horizons measured using geophysical methods; 

the profiles are defined in the AXIS_PROFILE table, each profile being identified by a type 
of material defined in the AXIS_STRATA table. The color of each profile is the one 
associated to the material of code S defined in the MATERIAL table for the SPEC site. If 
the material is not defined in the MATERIAL table with the S code, the color of the 
Axis_Profile curve is then used. 

• a 3D topographic background, if requested by the user. See paragraph 4.1.1.  
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9. THE SUB-GRAPHS 

The sub-graphs define the identification of the borings (HEADER sub-graph) as well as the 
columns of properties of the borings in the tridimensional view.  
 
Figure 1-2 shows the graph and sub-graph editing window. Contrary to PLAN_VIEW, the 
position and dimensions of the sub-graphs are not relative to the page. 
 
The position of the top of each boring is its position in X, Y and Z, in the 3D view. 
 
The display of each boring represented in the 3D view is done according to its apparent dip, i.e. 
the tip of the boring’s projection onto the plane perpendicular to the direction of observation of 
the 3D block. The angle and the length of the projection of each boring determine the angle and 
the length of the columns, therefore of the property graphs. 
 
For the property graphs, the Left, Width and Right fields define the layout of the columns with 
respect to the axes of the borings and the width of these columns. A property graph with a value 
of 0.00 in the Left cell will lie against the right side of the boring. If a width of 0.00 is defined for 
a sub-graph, the column is not displayed. The Bottom, Height and Top fields are not used.  
 

9.1. Creation of a property graph 

A property graph is created in the graph editing window. More details about graph editing are 
available in paragraph 3 of chapter 6 of the X3D guide. Figure 1-2 shows the graph editing 
window in Site. To create a property graph: 

• In the graph editing window: 

o Click on the Copy button, which creates a complete copy (with axes and curves) of the 
sub-graph selected, or substitute a graph by another.  

o Enter a negative value in the #P column of the graph. 

o In the scrolling list of the Name cell, select the name of the table from the Geotec 
database that contains the property to display. Many graphs can have the same name 
because they will not have the same number.  

o Define the position of the property column with respect to the borings in the Left, Width 
and Right cells. 

o Define the graph as Visible. 

o Click OK. 

• In the legend and curves editing window: 

o Select the new property graph in the scrolling list at the top of the window. 

o Delete all the curves from the previous graph.  

o Click on Insert and choose the name of the field from the table whose data are to be 
displayed, in the scrolling list of the Name cell. 

o Choose the type of curve and define its drawing attributes by clicking on the button 
under Delete.  

o Click OK. 

• Execute a new data query to fill the new graphs.  
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• In the axes editing window, configure the limits of the X-axis of the property graph.  
 

9.2. Types of curves in the sub-graphs 

There are several display types for the values in the property graphs: Default, Text, Point, 
Histo, Step, Polyline, Polygon, Color and Pattern. All types are described in details in 
paragraph 9 of the Log guide.  
 

9.3. Format of the numerical values 

The user can define the desired format for the display of numerical values in the Format field of 
the drawing attributes window for each curve; for example, "9.999" to have 3 decimals. 
 
No format is predefined for texts placed as graphic objects representing numerical values from 
the database. The user can define a format right after the value string in the object’s property 
window. For example, to display with 1 decimal number the dimensions of the site at the top of 
the report, the user will define a graphic object of Text type with the value 
“&&SITE.WIDTH"9.9" , &&SITE.HEIGHT"9.9" ”. 
 

9.4. HEADER sub-graph 

The HEADER sub-graph is the graph for the identification and positioning of the borings in the 
tridimensional view. For each boring, the HEADER sub-graph can show: 

• Its symbol (a marker or an identification box) 

• Its number 
 
The anchor point of the symbol of each boring is its position in X, Y and Z, in the 3D_VIEW. 
 
To define the identifiers in boxes, the user will modify the HEADER sub-graph. The test pits and 
trenches have rectangular or square boxes; the other borings, elliptical or circular boxes. The 
Left, Width, Right, Bottom, Height and Top fields reflect the position and size of the boxes 
that include the identifiers of the borings: 

• the width and the height define the size of the boxes, in millimeters; the two values must 
be positive. 

• the right and the left indicate the position, in millimeters, of the right and left sides of the 
boxes with respect to the verticals at the implementation points of the borings.  

• the bottom indicates at which distance, in millimeters, the bottom of the boxes will be 
located from the anchor points of the borings.   

 
To display a marker instead of the boxes, the height or width of the HEADER sub-graph must 
be 0. The bottom indicates at which distance will be located, in millimeters, the center of the 
markers from the anchor points of the borings. The other values are not used.  
 
For each boring, the Boring curve shows: 

• the marker for the boring, if it has a positive size and if the HEADER sub-graph has at least 
one dimension at 0.  

The marker is characteristic of the type and state of the boring; the marker used for each 
boring is the one in the current markers file whose name is the concatenation of the type 



1-14 Site - Site Data Management  
  
  

2019-09-27 The sub-graphs 
 

 

and state of the boring, for example TP_R for a realized test pit. If no corresponding marker 
is found, the one defined for the Boring curve of the HEADER sub-graph is used. 

The markers are centered on the verticals at the implementation points of the borings. 
Vertically, the centers of the markers are located at a distance indicated by the bottom 
value defined for the HEADER sub-graph, from the anchor points of the borings.  

• the line between the anchor point and the bottom value of HEADER; if the boring number 
is in a box, the border of the box will have the same drawing attributes as the line. 

• the boring number, with the text attributes. 

• the button identified Boring opens the drawing attributes window, where the user can 
define how the boring numbers, the boxes and / or the markers (color) will be drawn. The 
marker defined for this curve will only be used for the borings for which the concatenation of 
the type and state does not correspond to any marker in the .mrk file used. 

 
The drawing attributes of the HEADER sub-graph are not used. 
 

9.5. STRATIGRAPHY sub-graphs 

The stratigraphy of a boring is read in the STRATIGRAPHY table. Generally, the user displays 
the symbols representing the materials of the stratigraphic layers, by defining the CODE1 curve. 
Figure 1-5 shows the predefined curves associated to the CODE1 field. The user also often 
displays the color of the materials constituting the layers (MATERIAL field).  
 
The content of the other fields of the STRATIGRAPHY table can also be displayed. The 
STRATIGRAPHY sub-graph has predefined curves if the field displayed is CODE1, 
DEPTH_TOP or DESCRIPTION. 
 
9.5.1. Layers and sub-layers 

The layers and sub-layers are strata, which are records in the STRATIGRAPHY table. 

• the strata can be classified as three types: R (rock classification), S (simplified 
classification) or U (unified classification); 

o for an R type stratum, only one material can be defined; its code is entered in code 1; 

o for an S type stratum, up to six materials can be defined; their codes (one character 
each) are entered in code 1; 

the relative proportions of the materials are entered in the proportion field; the main 
material has a proportion of 1, a material with traces has a proportion of 4; the 
proportions must be entered in the same order as the materials in code 1; more than one 
material can have the same proportion; 

code 2 is used to indicate grain size or plasticity characteristics, it does not have an 
impact on the display;  

the line can be used to force the display of the top horizon limit using a specific format; 
the type of line requested will prevail over the one used for the lines belonging to the 
curve; the types of line that can be imposed are: 
▪ L0 blank line; 
▪ L1 continuous line; 
▪ L2 dotted line; 
▪ L3 dashed line; 
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the values of L0 to L3 entered in code3 in the previous versions of Geotec will be used if 
there are no values in Line. 

o for a U type horizon, two materials can be defined in code 1 from the scrolling list; they 
are separated by a dash; 

• each layer is limited by top and bottom depths and can have a text description. 
 
In addition to the strata: 

• descriptions can be added at specific depths along the boring; these records of type T (text) 
have a top depth but no bottom depth;  

if a record of type T has a negative depth, its description is displayed above the top line of 
the column, generally the ground surface; 

if there is no record of type T at a negative depth, Site automatically displays, at the top of 
the log, the title of the Elevation curve of the STRATIGRAPHY sub-graph associated to the 
DESCRIPTION field;  

• a description can be associated to the bottom of the boring; this record of type E has a top 
depth but no bottom depth; 

if there is no record of type E, Site automatically displays at the bottom of the column the 
title of the curve End_of_borehole of the STRATIGRAPHY sub-graph associated to the 
DESCRIPTION field; 
 

 

Figure 1-5 - Predefined curves of a STRATIGRAPHY sub-graph 
 
A stratum is a layer if its classification type, its code 1 or its proportions (for the S type) is 
different than the preceding stratum. 
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A horizon is a sub-layer if its classification type, its code 1 and its proportions are the same as 
those from the preceding stratum.  
 
The Layers and Sub-layers curves affect the stratigraphic layers and sub-layers. 
 
9.5.2. Display of the STRATIGRAPHY sub-graph for the CODE1 field 

Depending on the field specified as the non-predefined curve of the STRATIGRAPHY sub-
graph, the display associated to the curves varies and depends on Site. 
 
The only case described in this guide is the one where the field entered as the non-predefined 
curve is CODE1, which is the most common case. The reader can find information in paragraph 
13 of the Log guide about the display particularities when the field entered as the non-
predefined curve is DEPTH_TOP, DESCRIPTION, MATERIAL or another field.  
 
If the CODE1 curve is of Default type: 

• The column shows the stratigraphic symbols in graphic format if they are defined in the 
current .ptn pattern file, otherwise using a text format (see paragraph 9.5.3 about the 
display of stratigraphic symbols). 

• The Elevation curve displays nothing. 

• The Layers curve displays the upper limit of the layers. 

• The Sub-layers curve displays the upper limit of the sub-layers. 

• The End_of_borehole curve displays the end of boring limit and, if the record of type E has 
a code 1 of R, the bedrock symbol (illustrated below) indicating the refusal (or stop) of the 
boring on the bedrock, is drawn with the drawing attributes of the curve. 

  

 
  
If the CODE1 curve is a Text, the column displays the stratigraphic symbols using a text format 
and the predefined curves are not considered. The attributes of the limits of the layers and sub-
layers and of the textual stratigraphic symbols are those defined for the CODE1 curve.  
 
If the CODE1 curve is of a type other than Default or Text, nothing is displayed in the column.  
The types of the predefined curves are irrelevant. 
 
9.5.3. Display of the stratigraphic symbols 

To graphically display a stratigraphic symbol, an X3D pattern must be associated to the material 
code to be represented in the pattern file (.ptn) used (and the CODE1 curve must be of Default 
type). Otherwise, the material will be represented textually. 

• If a record is of type R, its code 1, for example CAL, will be represented graphically if there 
is a pattern named R_CAL, according to our example.  

• If a record is of type S, the graphic representations of the materials specified in code 1 will 
be superimposed if a pattern exists for each of these codes, whose name begins with S_ 
followed by the code to be represented and the proportion of the material;  
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for example, the CMG code with a proportion of 123 will be represented by three 
superimposed patterns if the patterns S_C1, S_M2 and S_G3 exist in the .ptn pattern file 
being used. 

• If a record is of type U, if a pattern exists for the complete code1, for example ML-MH, and 
whose name is U_ML-MH, it will be used for the graphic representation. 
 

The geotec8.ptn file provided with the installation contains patterns for most of the standard 
codes used. The user can refer to the X3D guide for information about how to look up, edit and 
create patterns.  
 

9.6. SAMPLE sub-graphs 

Often, a SAMPLE sub-graph is defined to show the N or RQD of the samples. The content of 
the other fields of the SAMPLE table can also be displayed. The curves SAMPLE_NO, STATE, 
USCS and MATERIAL have a special display. 
 
9.6.1. Display of the SAMPLE_NO curve 

If the SAMPLE_NO curve is a Text, only the sample number is displayed.  
 
If the SAMPLE_NO curve is of Default type, it shows the sample numbers concatenated to their 
type, for example SS-01; this layout cannot be modified. 
  
The user can modify the attributes of the text and line showing the top and bottom depths of 
each sample.  
 
9.6.2. Display of the STATE curve  

If the STATE curve is a Text, the states of the samples are represented by their textual code. 
 
If the STATE curve is of Default type, a graphic symbol represents the state of the samples 
along their entire length. 
 
Four symbols, shown in figure 1-6, are generally used to represent the state of the samples. To 
display these symbols, the drawing attributes of the STATE curve must be defined as follows: 

• The Line is defined with the color, type and size desired; the line attributes apply to all 
states; the line is used as the symbol border and for the cross, for a remolded sample;  

• The Pattern must contain an X3D pattern (usually a hatched pattern); this pattern applies 
only to Intact samples. 

• The Filling applies to the Lost and Core samples; it must be defined in two steps:  

o It must be defined with the desired color;   

o It must be "erased" with the "-" button for the filling not to affect the intact samples.  
 

The remolded samples are the only ones with a symbol set by the Site module; only the line 
attributes forming the cross can be modified.  
 
The lost percentage of a sample can be graphically represented at the bottom of the sample 
with a height proportional to the lost percentage. To do this, indicate a period of 2 for the 
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STATE curve. The filling attributes will be used. If a sample has a recovery of 0%, it is drawn 
as ‘lost’. 
 

 

Figure 1-6 - Symbols representing the state of the samples 
 
9.6.3. Display of the USCS curve  

If the USCS curve is of Default type with a period of 1 or less, the column shows the X3D 
patterns defined in the current .ptn patterns file, named “U_USCS”, for example, U_GW. 
 
If the USCS curve is of Default type with a period greater than 1, the column shows the colors 
associated to the materials of code U defined in the MATERIAL table for the SPEC site. 
 
If the USCS curve is a Text, the column shows the USCS classification in text format. The 
attributes of the text and of the limits between the samples are defined for the USCS curve.  
 
If the USCS curve is of a type other than Default or Text, nothing is displayed in the column.  
 
9.6.4. Display of the MATERIAL curve  

If the MATERIAL curve is of Default type, the column shows the background colors for the 
materials constituting the samples (materials of the borrow pits). The colors are the ones 
associated to the materials of code S defined in the MATERIAL table for the SPEC site. 
 
If the MATERIAL curve is a Text, the column shows the codes of the materials in text format. 
The attributes of the textual materials and of the limits between the layers are defined by the 
MATERIAL curve.  
 
If the MATERIAL curve is of a type other than Default or Text, nothing is displayed in the 
column.  
 
9.6.5. Selection of the types of samples to present  

Site allows the user to restrict the display of the samples to just one type. To do this, indicate 
the type of samples to display in the Series column; for example, "SS" for split spoons. 
 
Each cell of the Series column has a scrolling list which displays all the types of samples 
inserted in the current database.  
 
The user can select a different type for each curve of a SAMPLE sub-graph.  Only the values 
associated to the selected type will be displayed.  If the cell of the Series column is empty or if it 
contains "@@", all the samples will be represented for this curve.  
 

9.7. PIEZOMETER sub-graph 

The installations of the piezometers, observation and supply wells as well as the seals, lanterns 
and piezometric levels are shown in the PIEZOMETER sub-graph.  
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Site reads the information about the piezometers in the PIEZOMETER table, the information 
about the seals and lanterns in the PIEZOMETER_SEAL table and on the piezometric levels in 
the PIEZOMETRIC_LEVEL table. 
 
The PIEZOMETER sub-graph can only contain the predefined curves. Paragraph 15 of the Log 
guide gives a complete description of each predefined curve of PIEZOMETER.  
 

9.8. LIMITS sub-graph 

The LIMITS sub-graph displays the results of the Atterberg limits measurements: the plastic 
limit, the liquid limit and the water content. Site reads the data in the LIMITS table. 
 
When a LIMITS sub-graph is created, the predefined curve PL-LL is created. This curve shows 
a typical display, i.e. two vertical dashes representing the plastic and liquid limits and joined by a 
horizontal line, as well as an empty circle representing the water content. The symbols are 
positioned at the depth corresponding to the center of the samples. 
 
The user can open the drawing attributes window and modify the marker, which will then be the 
symbol for the water content.  The line can be modified; it will have an effect on the horizontal 
line and the vertical dashes for PL and LL.  The text is displayed by default, but can be modified 
or removed (“-” button) via the attributes window.  
 
If the user does not want to display any marker, he will enter a size of 0 for the PL-LL curve. If 
he only wants the markers for the limits, he will enter a period of 0 in the attributes window for 
the curve.   
 
It is also possible to add curves for the W, LL and PL fields to impose a specific display; for 
example, to connect all the plastic limits, the liquid limits and the water contents, select the 
Polyline type for these curves.  Each polyline is defined by the line attribute. If the W, LL and 
PL curves are of Point type, only the markers will be displayed.  
 

9.9. CONSOLIDATION sub-graph 

The CONSOLIDATION sub-graph displays the measurements of consolidation pressures read 
in the CONSOLIDATION table. 
 
When a CONSOLIDATION sub-graph is created, the predefined curve PCMIN-PCMAX is 
created. This curve shows a typical display, i.e. two vertical dashes representing the minimum 
and maximum preconsolidation stresses and joined by a horizontal line, as well as an empty 
down arrow representing the probable preconsolidation stress.  The symbols are positioned at 
the depth corresponding to the center of the samples. 
 
The user can open the drawing attributes window and modify the marker, which will then be the 
symbol for the probable PC.  The line can be modified; it will have an effect on the horizontal 
line and the vertical dashes for the minimum and maximum preconsolidation stresses.  The text 
is displayed by default, but can be modified or removed (“-” button) via the attributes window.  
 
If the user does not want to display any marker, he will enter a size of 0 for the PCMIN-PCMAX 
curve. If he only wants the markers for the minimum and maximum stresses, he will enter a 
period of 0 in the attributes window for the curve.   
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It is also possible to add curves for the other fields of the table, the same way as for the curves 
of the LIMITS sub-graph (see paragraph 9.8). 
 

9.10. ROCK_JOINT sub-graphs 

All the fields from the ROCK_JOINT table can be displayed in curves of a ROCK_JOINT sub-
graph.  
 
The ALPHA (or ANGLE in the previous versions of Geotec), DIP and TYPE curves have a 
special display.  These three curves cannot be displayed in the same sub-graph.  
 
The curve associated to the ALPHA (or ANGLE) field has a specific display if it is of Default 
type. It then displays the joints as lines inclined according to their angle relative to the core axis 
and centered on their average depth. The lines have a length of 80% of the column’s width.  
The elements that can be edited for the ALPHA (or ANGLE) curve depend on the type of curve 
chosen. 
 
The display is similar for the curve associated to the DIP field, except that the line is inclined 
relative to the horizontal, in counter-clockwise direction. 
 
The curve associated to the TYPE field is used to display information relative to three fields: 
TYPE and of one of the following pairs depending on the reference taken for the measurement 
of the angles: ALPHA and BETA, or DIP and DIRECTION. If a marker named J_type is defined 
and an angle is entered in the database for the same depth, the marker representing the type 
will be displayed at the location of the value between 0 and 90 on the X axis, and will be inclined 
according to the azimuth value (between 0 and 360).  If no azimuth value is defined, a value of 0 
(vertical) will be used. For this display, the TYPE curve must be of Default type. If the curve is 
of Text type, only the type values will be displayed textually.  
 

9.11. CPTU_ZONE sub-graphs 

It is possible to display the ranges of SBT zones calculated as histograms or as textual 
description for the results of piezocone tests. For this, the curve #1 of the CPTU_ZONE sub-
graph must be associated to the SBT field.  

• If the Series cell of the SBT curve is empty, the column will display the ranges of SBT 
zones as histograms. The period for the curve must be 0 or a filling must be defined for the 
curve to show the different colors for the ranges.  

• If the Series cell of the SBT curve contains "@@", the column will display the SBT ranges 
as descriptions.  If the EQUIVALENCE table contains the description of the zones as 
equivalences to their value, this description is displayed; otherwise, the numbers of the 

zones are displayed. 
 

Nine predefined curves are automatically included in the Page graph when the SBT curve of 
CPTU_ZONE is displayed. These curves named "Zone_1" to "Zone_9" are used to define the 
colors of the various values of SBT zones.  A series of colors commonly used is proposed by 
default. However, the user can modify these colors by editing the "Zone_n" curves. 
 

9.12. Display of property values or of concentrations of contaminants 

The PROPERTY_VALUE table contains the values of various properties according to depth; the 
properties are defined by the user. Also, the CONCENTRATION table contains the 
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concentrations according to depth of various contaminants defined in the CONTAMINANT 
table. 
 
To display the values of the PROPERTY_VALUE table for a specific property in a column, the 
user must: 

• associate the PROPERTY_VALUE table to a sub-graph; 

• define at least one curve associated to a field of the table in the curve editing window; 
usually, it is usually the CVALUE field. 

• in the Series column of the curve definition, enter the property for which values are to be 
represented;  
 

The display in a column of values from the CONCENTRATION table for a contaminant is done 
the same way, with the name of the contaminant in the Series cell. 
 

9.13. Display of elevations and information associated to a depth curve 

In a sub-graph other than the ones described above, we can define curves associated to a field 
starting with DEPTH_ or finishing with _DEPTH.  These curves must be of Default type.  We 
can add information at each depth in the sub-graph by entering the information to be displayed 
in the title of the DEPTH_xxx or xxx_DEPTH curve. 
 
The information displayed can be any text. It can contain the value of a field from a Geotec 
table; the syntax is then &&table_name.field_name"format" to display the values, or 
@@table_name.field_name"format" to display the values or eventual equivalences (see 
paragraph 9.14). The format is not required. 
 
For example, the user can create a column to display the initial and stabilized depths of the 
water table using a marker and the reading date. For this:  

• the user associates the BORING table to a sub-graph; 

• the user defines two curves. The first curve is associated to the WATER_DEPTH field and 
has this expression in the Title cell: &&BORING.WATER_DATE"yyyy-mm-dd". The 
second curve is associated to the STABLE_WATER_DEPTH field and has this expression 
in the Title cell: &&BORING.STABLE_WATER_DATE"yyyy-mm-dd". A marker for the 
water level can be associated to each curve. 

 
It is also possible to display the elevations corresponding to the depths presented.  These 
elevations are displayed if the ELEVATION keyword is specified in the title of the curve. These 
keywords cannot be included in a string. The dip of the boring is taken in account to determine 
the value of the elevations. 
 
If no title is provided for a DEPTH_xxx or xxx_DEPTH curve of Default type, the depth is then 
displayed. 
 
If the user wants to display the depths and the elevations, two DEPTH_xxx or xxx_DEPTH 
curves of Default type must be created in the sub-graph. One of the titles will remain empty, 
while the other will be ELEVATION. By aligning the characters of a curve by the top and the 
other by the bottom, both texts will not be superimposed in the graph.  
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9.14. Display of equivalences to values 

It is possible to display equivalent expressions to some values in a curve if the following 
conditions are met: 

• The curve does not belong to a sub-graph with predefined curves; 

• The curve does not belong to a sub-graph representing the CONCENTRATION or 
PROPERTY_VALUE table. 

• The curve does not represent a DEPTH_xxx or xxx_DEPTH field; 

• Expressions equivalent to one or many values are defined in the EQUIVALENCE table or in 
the LIST_ENG table for the field represented by the curve; 

• The @@ expression is entered in the Series column of the curve. 
 

Regardless of whether the field values are numerical or textual, if the equivalent expressions 
are textual, they will only be displayed if the curve is of Default or Text type.  If the equivalent 
expressions are numerical, they can be displayed regardless of the type of curve. 
 
 

10. INTERACTIVE EDITING 

10.1. Interactive editing in 3D view 

In 3D mode, the user can click with the right button of the mouse to display the contextual menu 
shown in figure 1-7. Create and Information are active only if the mouse is over a property 
column.   
 
The first item is used to create a new record in the table whose data are displayed in the 
column. The depth clicked will be displayed by default for the new record. 
 
The Information option opens the correct entry form on the data of the record where the user 
clicked. Double-clicking on data has the same role.  
 
With the interactive menu, it is also possible to launch the modules of Geotec to show the 
various types of data that can be displayed for the current boring, site or axis. 
 

 

Figure 1-7 - Interactive menu in 3D view 
 

10.2. Interactive editing in 2D view 

In 2D mode, the user can right click anywhere in the plan view outside the geotechnical entities 
to display the contextual menu shown in figure 1-8.  
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Figure 1-8 - Interactive menu in 2D view 
 
10.2.1. Creating a site 

By selecting Create Site, the cursor takes this format: . If the user wants to cancel right away, 
right click and select Cancel.  To create the site, left click at one corner of the new site, hold 
down and move the cursor to the diagonally opposite corner; a dotted line shows the area 
created. When the button of the mouse is released, the site entry form is displayed.  
 
By default, the MTM and NAD83 systems are used. The X and Y coordinates of the bottom left 
corner, its longitude and latitude, the zone used for the calculation, as well as the width and 
height of the area are automatically entered. If Google Map is displayed in background, the 
zone is determined from there. Otherwise, the zone used is the site’s zone previously displayed.  
 
The user then enters the site number and any other information in the entry form, and saves the 
new site.  
 
10.2.2. Creating an axis 

By selecting Create Axis, the cursor takes this format: . Left click at each point of the axis. A 
dotted line shows the movement of the cursor. When the last point of the axis is defined, right 
click to display the pop-up menu and select Cancel to erase the axis being created, or 
Terminate to edit and save the new axis. The axis entry form is then displayed and shows the 
coordinates of each point clicked. The user can then enter the axis number and any relevant 
information in the entry form, and save.   

 
10.2.3. Modifying an axis  

When the cursor is on an axis, it takes this format: . By right clicking, the menu shown in 
figure 1-9 is displayed.  
 
The first 2 items are inactive except for planned axes (state of axis: P).  With add an axis 

point, the cursor becomes . The point will be added between the two closest points to the 
cursor. A message is displayed, showing the exact coordinates of the point. To stop the addition 
of points, right click and select Terminate. When the cursor is over an axis point and there are 
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more than two points in the axis, the option Delete this Axis Point is active. A message is 
displayed to confirm the deletion of the point.  When the cursor is on an axis point, it takes this 

format: .By clicking on the point, it takes the format . Move the point to the desired position, 
and release the button of the mouse; a message is displayed to confirm the move.  
 

 

Figure 1-9 - Editing an axis 
 
The Information option opens the axis entry form on the current axis. It is also possible to 
launch the Pro module to show the profile of the current axis.  

 
10.2.4. Creating borings 

By selecting Create Borings, the cursor takes this format: . Left click at the location of the 
first boring. A dotted line shows the movement of the cursor. Left click as many times as desired 
to add borings. When the last boring is defined, right click to display the pop-up menu and select 
Cancel to erase all borings being created, or Terminate to edit and save the new borings. The 
window shown in figure 1-10 is then displayed.  
 

 

Figure 1-10 – Creating new borings 
 

The boring editing window shows: 

• The region number, associated to the site selected.  

• The site number. The user can select another from the list of all sites currently displayed. 

• The boring type. The user can select another from the list of types of borings that have a 
defined maximum depth. 
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• The year of the projected borings, as “yy”. This is added to the boring numbers. 

• The number of borings clicked. 

• The number for the beginning of the sequence. By default, the number is one greater 
than the largest boring number found in the site selected.  

• The first boring number. The number is a concatenation of the type - sequence - year.  

• The maximum depth of all planned borings. 

• The axis number to which the borings are attached.  
 
When the user clicks OK, the borings are added in the plan view using the marker for the 
corresponding type of planned borings, and their coordinates are also entered in their record. 
 
10.2.5. Modifying a boring  

When the cursor is on a boring, the contextual menu shown in Figure 1-11 is displayed when 
right clicking. 
 
The first item is inactive except for planned borings (state of boring: P).  When the cursor is 
over a planned boring, the option Delete this Boring is active. A message is displayed to 

confirm the deletion.  When the cursor is on a planned boring, it takes this format: .By clicking 

on the boring, it takes the format . Move the boring to the desired position, and release the 
button of the mouse; a message is displayed to confirm the move.  
 

 

Figure 1-11 - Editing a boring 
 
The Information option opens the boring entry form on the current boring. It is also possible to 
launch the Log or Lab modules to show data from the current boring.  
 
10.2.6. Selecting borings 

By clicking Select Borings, the cursor takes this format: . Click and drag a rectangle 
containing the desired borings. The borings selected are then displayed in blue. The user may 
also select or unselect borings by pressing the [Ctrl] key and clicking on the desired borings.  
 
When all desired borings are selected, right click to display the menu shown in figure 1-12. The 
option Create a Group of Borings will open the selection entry form; each boring selected is 
identified with its site and boring number.  A selection number corresponding to the current 
boring number is displayed by default, and can be modified. The user then enters any other 
information in the entry form, and saves the new group of borings.  
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With the option Delete these Borings, all borings selected and whose state is Planned will be 
deleted, after confirming the message displayed.  Records for borings of another state cannot 
be deleted this way. 
 

 

Figure 1-12 - Selection of borings 
 
10.2.7. Creating and modifying a rectangular limit 

By selecting Create Rectangular Limit, the cursor takes this format: . If the user wants to 
cancel right away, right click and select Cancel.  Left click at one corner of the rectangular limit, 
hold down and move the cursor to the diagonally opposite corner; a dotted line shows the area 
created. When the button of the mouse is released, the limit entry form is displayed; the X and Y 
coordinates of the four corners of the limit are automatically entered. The current site number is 
displayed as reference site. The user enters the limit number and any other information, and 
saves the new rectangular limit. 
 
10.2.8. Creating and modifying a polygonal limit 

By selecting Create Polygonal Limit, the cursor takes this format: . If the user wants to 
cancel right away, right click and select Cancel.  Left click at each point of the polygonal limit. A 
dotted line shows the movement of the cursor. When the last point of the polygonal limit is 
defined, right click to display the pop-up menu and select Terminate. The limit entry form is 
then displayed; the X and Y coordinates of all points of the limit are automatically entered. The 
current site number is displayed as reference site. The user enters the limit number and any 
other information, and saves the new polygonal limit.  

 
Any rectangular or polygonal limit can be modified with the mouse. When the cursor is on a 

limit, it takes this format: . By right clicking, a contextual menu is displayed.  
 

When adding a point to the limit, the cursor becomes . The point will be added between the 
two closest points to the cursor. A message is displayed, showing the exact coordinates of the 
point. To stop the addition of points, right click and select Terminate.  
 
When the cursor is over a point of the limit, the option Delete this Point from Limit is active. A 
message is displayed to confirm the deletion of the point.   
 

When the cursor is on a point of the limit, it takes this format: . By clicking on the point, it 

takes the format . Move the point to the desired position, and release the button of the 
mouse; a message is displayed to confirm the move.  
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CHAPTER 2. SM2 - SITE MAPPING AND MODELING 

The SM2 library is primarily used to edit topographic maps, to produce data terrain models 
(DTM) by dual kriging or triangulation, to perform mathematical operations on DTMs and to 
establish iso-values contours.  
 
SM2 uses a Graphical User Interface (i.e. with windowing) that is compatible with Microsoft 
Windows 7, 8 and 10. SM2 uses the X3D graphic library created by Sobek Technologies Inc. to 
define the presentation style, view and edit graphic results. Please refer to the X3D guide for all 
details. 
 
 

1.  LAUNCHING THE SM2 LIBRARY 

The SM2 library is integrated in the Site module, opened by double-clicking on this icon. The 
SM2 Mode option of the Tools menu or this button opens the SM2 library.  Site always opens in 
the last mode used (Site or SM2). 
 
No database is necessary for with SM2. When Site or SM2 is first launched, the following files 
are loaded from C:\Geotec80\Style: 

• the markers file geotec8.mrk; 

• the patterns file geotec8.ptn; 

• the style file site_landscape.sty which is a classic presentation model showing a plan 
view. 

 
The user can begin working with this initial presentation, or open another style file included with 
the software.  He can modify the style file and save it in a new presentation.  In subsequent 
loadings, Site opens the style, markers and patterns files that were in use when Site was 
closed.  
 
 

2. FILE, EDIT, INSERT, WINDOW AND HELP MENUS 

None of the options of the File, Edit, Insert, Window and Help menus is specific to SM2.  The 
detailed description of each option of these menus is done in chapters 2, 3, 4 and 8 of the X3D 
guide.  
 
 

3. VIEW MENU 

The 2D View and 3D View options of the View menu and this button are used to change the 
view of the PLAN_VIEW graph. In the axes editing window, it is possible to change from 2D to 
3D view and vice-versa for PLAN_VIEW.   
 
The OpenGL mode is used to view solids and surfaces with hidden lines and faces and 
shadows in 3D. The XVT mode is the standard display mode.  
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4. TOOLS MENU 

The options of the Tools menu are used to define the utilisation parameters of SM2 and to edit 
certain graphic components produced by SM2: the characteristics of the graphic page, the 
PLAN_VIEW graph, the axes, the markers and patterns used.  All these options are described 
in details in chapter 6 of the X3D guide. Options is not used in SM2.  
 
The SM2 Mode option is checked when the SM2 library of site mapping and modeling is being 
used.  By unchecking the option or the button, SM2 is closed and switched to the Site module 
for the management of geotechnical data.  
 
 

5. ORGANIZATION OF A GRAPHIC OUTPUT 

The definition of graphs is established and updated in the graph editing window opened by 
selecting the Graphs… option of the Tools menu or by clicking this button. More details about 
the graph editing are available in paragraph 3 of chapter 6 of the X3D guide.  
 
Each graph is identified by a unique number in the # column. The first graph is always Page 
with # 0.  This graph represents the graphic page and cannot be deleted.  
 
In SM2, only the PLAN_VIEW graph is used, and shows the content of the data file opened or 
of the files produced by the various modeling operations.  This graph can be set in 2D or 3D, in 
XVT or OpenGL mode.  The Left, Width, Right, Bottom, Height and Top fields define its 
position and dimensions; the user can modify these values.  
 
 

6. MAPPING MENU 

The Mapping menu, shown in figure 2-1, is specific to the SM2 library. The menu options are 
used to edit the content of cartographic files. These do not include “grid” files such as the .dem, 
.dtm, .k2d, .tin, etc. files.  
 

 

Figure 2-1 - Mapping menu 
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6.1. Properties and editing of a cartographic entity 

The Properties option of the menu is checked by default, until another option is selected.  
 
The user can left click on any entity in the cartographic file. The entity is then highlighted and 

the cursor takes the shape . The highlighting attributes can be modified (see paragraph 
7.1.8). By holding down the left button of the mouse, some properties of the entity are displayed 
in the status bar: the name of the entity’s layer, the number of the point left of the location 
clicked (left is towards the 1st point of the entity), the total number of points, and the proportion 
factor indicating the distance between the point to the left and the location clicked, between 0 
and 1. Figure 2-2 shows an example. 
 
By double-clicking on the entity, a property window is opened, as illustrated in figure 2-3. The 
Properties option of the popup menu displayed with the right button of the mouse is equivalent. 
 

 

Figure 2-2 - Example of a highlighted entity and its properties 
 
6.1.1. Name of layer 

The Layer field contains the name of the layer to which the cartographic element belongs. This 
value can be modified. The scrolling list contains the names of all the layers belonging to the 
current data file. 
 
If the user enters a new layer name, the entity will belong to it and this new layer will be added, 
with the attributes of the current element. The user will be able to edit it via the Layer Editing 
option of the Modeling menu and to save it by saving the data file. See paragraph 7.2 for the 
layer editing. 
 
6.1.2. Type of entity 

The Type field contains the type of the cartographic element. The scrolling list contains all the 
possible types of elements: Polyline, Points and Polygon. 
 
6.1.3. Elevation of the points 

The user can decide on the Elevation type. 
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• Nil: the elevation of each point is fixed at -999.000; the points with this elevation are 
ignored in the surface modeling operations. 

• Constant: all the points have the same elevation, which is entered in the Elevation field. 

• Variable: each point has its own elevation which can be edited in the Z column of the table 
of points.  

 

Figure 2-3 - Property window of an entity 
 
6.1.4. Closing a polyline 

The checkbox labelled Closed is only active if the current cartographic element is a Polyline 
type. This box is used to define if the polyline will be closed or not. 
 
Unlike a closed Polyline element, a Polygon element can have as an attribute the filling 
defined for the element or for the layer to which it belongs. 
 
6.1.5. Drawing attributes of the entity 

When the box Attribute by layer is checked, the entity takes the same drawing attributes as the 
layer to which it belongs. 
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Note that if the attributes of a layer are modified (see paragraph 7.2), all the elements belonging 
to this layer and whose Attribute by layer box is checked will be modified.  
 
If the box is not checked, the user can define the desired drawing attributes for the element by 
clicking on the attributes button labelled with the layer name. This button shows the current text, 
line and filling attributes for the entity.  Clicking on this button opens the drawing attributes 
configuration window (see chapter 9 of the X3D guide). 
 
6.1.6. Table of points 

The table at the bottom of the property window shows the X and Y coordinates and the 
elevation of the points of the cartographic element.  
 
The row selected in the table corresponds to the point closest to the location where the double-
click or the click with the right button was done to open the property window.  
 
The user can edit the X and Y coordinates of the points and eventually their elevation, if the type 
is Variable. 
 
The total number of points belonging to the current element is displayed in the Nbr. points field. 
 
The length of the perimeter of the cartographic entity is displayed in the Length field. This value 
applies only to the polylines and polygons. The perimeter does not include the parts of an entity 
that are not linked. 
 
The area of a polyline or polygon is also calculated and displayed in the Area field. In the case 
of an open polyline, the program closes the entity for the calculation. 
 

6.2. Creating a cartographic entity 

The New Entity option of the Mapping menu has 3 options: Points, Polyline and Polygon. By 
selecting one of the 3 options, the property window opens.  
 
The layer displayed by default will be the layer of the last entity selected, or will be null if no 
entity was selected before. The user chooses the desired layer in the scrolling list or enters the 
name of a new layer. 
 
The type of the element is by default the one of the selected option, but can be modified from 
the scrolling list. 
 
The type of elevation can then be selected. With Nil, the Elevation field is set to -999 and 
becomes inactive. With Constant, the user can enter the value for all the points in the 
Elevation field. With Variable, the n/a value is entered in the Elevation field and it becomes 
inactive. The user will define the elevation of each point of the entity during its creation.  
 
For a new polyline, the user can check Closed to automatically close the polyline when it is 
created.  
 
The user can check the Attribute by layer box. The entity will then take the attributes of the 
layer to which it belongs. Otherwise, the user can define the desired drawing attributes for the 
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element by clicking on the attributes button labeled with the layer name, which opens the 
drawing attributes window (see chapter 9 of the X3D guide). 
 
When the characteristics of the entity to be created are defined, click OK and the cursor takes 

the format . For each point, each point of a polyline or each point of a polygon, place the 
cursor at the desired location and click with the left button of the mouse. A dotted line will follow 
the last point clicked in the case of polylines and polygons. If the elevation is variable, a box will 
open after each click to enter the elevation of the point. The elevation proposed by default is the 
one of the previously created point. To end the creation of the entity, click with the right button of 
the mouse to display a popup menu and select Terminate.  
 

6.3. Copying a cartographic entity 

The user can create a copy of a cartographic entity by selecting the Copy Entity option of the 
Mapping menu which becomes checked, or this button.  
 
Select the entity to copy by clicking on it with the left button of the mouse. The cursor then takes 

the format . Click again on the entity and hold down the left button while dragging the copy of 
the entity to the desired location, and release. A dotted line follows the movement. You can 
create as many copies as needed, the option remaining active. To copy another entity, simply 
select it and repeat the steps. 
 

6.4. Moving a cartographic entity 

The user can move a cartographic entity by selecting the Move Entity option of the Mapping 
menu which becomes checked, or this button.  
 
Select the entity to move by clicking on it with the left button of the mouse. The cursor then 

takes the format .  Click again on the entity and hold down the left button while dragging the 
entity to the desired location, and release. A dotted line follows the movement. You can move 
the entity as many times as needed, the option remaining active. To move another entity, select 
it and repeat the steps. 
 

6.5. Linking two cartographic entities 

The user can link two cartographic entities by selecting the Link Two Entities option of the 
Mapping menu which becomes checked, or this button.  
 
This option is under development. 
 

6.6. Splitting a cartographic entity 

The user can split a cartographic entity by selecting the Split Entity option of the Mapping 
menu which becomes checked, or this button.  
 
Select the entity to split by clicking on it with the left button of the mouse. The cursor then takes 

the format . Then, click on the segment to delete. This operation cannot be done on an entity 
with less than 3 segments or on the end segments. You can split the entity as many times as 
needed, the option remaining active. To split another entity, select it and repeat the steps. 
 
Note: if a polygon is split, the entity now split will remain of type “Polygon”. 
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6.7. Deleting a cartographic entity 

The user can delete a cartographic entity by selecting the Delete Entity option of the Mapping 
menu which becomes checked, or this button. 
 
Select the entity to delete by clicking on it with the left button of the mouse. The cursor then 

takes this format .  Click again on the entity to delete it.  You can delete as many entities as 
needed, the option remaining active. To delete another entity, simply select it and repeat the 
steps. 
 

6.8. Adding a point 

The user can add a point to an entity. First, select the entity to edit by clicking on it with the left 
button of the mouse. Then, select the Add Point option of the Mapping menu which becomes 
checked, or this button.   
 

The cursor then takes this format .  A dotted line follows the cursor and shows the adjusted 
shape of the entity linking the two closest points. Left click to add the new point. If the point is 
added to an entity with variable elevation, the elevation of the point to its right (towards a greater 
point number) is given by default, but the user can modify it in the property window. To add 
another point, select Add Point again.  
 

6.9. Moving a point 

The user can move a point of an entity by selecting the Move Point option of the Mapping 
menu which becomes checked, or this button.  
 
Select the entity containing a point to move by clicking on it with the left button of the mouse. 

The cursor then takes this format . Then, click on the point to move, hold down and drag the 
point to the desired location, and release. A dotted line follows the movement.  You can move 
any point of the entity as many times as needed, the option remaining active. To move a point of 
another entity, select it and repeat the steps. 
 

6.10. Deleting a point 

The user can delete a point of an entity by selecting the Delete Point option of the Mapping 
menu which becomes checked, or this button.  
 
Select the entity containing a point to delete by clicking on it with the left button of the mouse. 

The cursor then takes this format . Then, click on the point to delete. The shape of the entity 
is automatically adjusted.  You can delete as many points of the entity as needed, the option 
remaining active. To delete a point of another entity, select it and repeat the steps. 
 

6.11. Pop-up menu 

By selecting an entity and clicking on it with the right button of the mouse, a popup menu is 
displayed, showing the options “Copy” to “Add Point” (paragraphs 6.3 to 6.8) as well as the 
Properties option (paragraph 6.1). 
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If the popup menu is called when the cursor is on a point of the entity, the options “Move Point” 
and “Delete Point” are also available (paragraphs 6.9 and 6.10). A message asks the user to 
confirm a point deletion. 
 
 

7. MODELING MENU 

The Modeling menu, shown in figure 2-4, is specific to the SM2 library. It allows: 

• To prepare and edit cartographic maps, 

• To prepare data terrain models by kriging or triangulation, 

• To perform operations on the data terrain models, 

• To calculate isovalue contours, 

• To perform volume calculations. 
 

 

Figure 2-4 - Modeling menu 
 

7.1. Map management 

The Map Management option of the Modeling menu opens the map editing window shown in 
figure 2-5.  
 
7.1.1. Data file 

The File field of the map editing window shows the name of the file whose content is displayed 
in the plan view. This file is opened via the Open Data option of the File menu. A file can also 
be opened by clicking on the button at the extreme right of the File field, which opens the 
Windows file selection window. The selection of a file replaces the content of the plan view and 
updates the fields of the map editing window. The directory of the current data file is indicated 
above. 
  
7.1.2. Import of a data file 

If the data file is cartographic (all except the .dem, .dtm, .k2d, .tin, .grd, .stl and .igs files), it is 
possible to add a data file to the one already opened, by clicking on the Import button, which 



 SM2 - Site Mapping and Modeling 2-9 
 
 

Modeling menu 2019-09-27 
 

 

opens the Windows file selection window. The selected file will be combined to the current file, 
which can then be saved with the Save as button at the bottom of the window.  
 
7.1.3. Background file 

A background file cannot be edited. It can be opened via the New Data option of the File menu 
(see chapter 2 of the X3D guide). Then, the background field of the map editing window will 
contain this file name.  
 
The user can also open a background file, or even more than one successively, in the map 
editing window. Click on the “+” button, right of the background field, to open the Windows file 
selection window. When a background file is selected, it is added to the plan view. 
 
If the domain of the selected background file is completely disjoint from the domain of the 
foreground file, a message warns the user and the file is not opened. If the domain of the 
selected background file is partially disjoint from the domain of the foreground file, a message 
warns the user but the file is still opened.  
 
The background field shows the identification of the last selected file. The scrolling list 
associated to this field shows all the background files displayed in the plan view. Click on the “-” 
button to remove the selected background file. The plan view is then automatically adjusted.  
 
7.1.4. File of polygonal limit 

The user can add a file of polygonal limit in the plan view by clicking on the button at the 
extreme right of the Polygonal limit field, which opens the Windows file selection window for 
the .lim files. The selection of a file displays it on the plan view. 
 
When a polygonal limit is displayed in the plan view, the user can clip the data displayed in the 
foreground inside or outside the limit.  
 
The user selects the option Delete points outside or inside of the polygonal limit. Then, he 
clicks on the Clip button to purge the data either outside or inside the limit.  
 
The checkbox Add points to polylines intersecting clipping boundary is used so that no 
data is lost in the clipping. Indeed, if the box is not checked, any polyline intersecting the 
polygonal limit will be deleted during the clipping. By checking the box, for each polyline 
intersecting the polygonal limit, a point is added at the intersection of the polyline and the limit, 
which allows deleting only the part of the polylines exceeding the limit.  
 
7.1.5. File domain and additional information 

The next section shows the characteristics of the file’s cartographic domain. The file domain is a 
rectangle defined by the coordinates of its bottom left corner, by its width, its height and the 
angle of its sides with the cardinal directions. In addition to the domain limits, there are 
elevation limits Z max and Z min. Generally, the file’s data are all contained in its domain, but 
SM2 allows defining a smaller domain, leaving some data outside the domain. 
 
The type field indicates the type of file opened. The version field indicates with which version of 
SM2 the file was created. The reference system is not used.  
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Figure 2-5 - Map editing window 
 
7.1.6. Operations on the file domain 

The Update box is used to automatically update the file domain depending on the operations 
done. For example, if the user imports a file, the file domain can be updated to take into account 
the new data. Similarly, after clipping around a polygonal limit, the file domain can be updated to 
include only the remaining data.  
 
The attributes button is used to define the attributes of the limit of the domain defined with the 
Define < button, with the line and marker (for the corners of the domain) attributes.  
 
The Duplicates button is used to eliminate identical entities in a file. Only the entities being 
exactly the same (same coordinates for their points) will be deleted. 
 
The Translation button is in development.  
 
By clicking on the Define < button, the map editing window goes in background and the cursor 

takes this format: . The user can then define a new rectangular domain in the plan view, by 
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clicking at one of the corners and dragging to the opposite corner, then releasing the left button 
of the mouse. The window then reappears, showing the new values for the file domain.  
 
The Purge button is used to delete the data outside the defined file domain, in plan and 
elevation. The user defines the domain directly in the fields, or with the Define < button. The file 
can then be saved.  
 
Please note than the option Add points to polylines intersecting clipping boundary is also 
used for the purge. Indeed, if the box is not checked, any polyline intersecting the domain limit 
will be deleted during the purge. By checking the box, for each polyline intersecting the domain 
limit, a point is added at the intersection of the polyline and the limit, which allows deleting only 
the part of the polylines exceeding the domain limit.  
 
7.1.7. Data domain 

The bottom of the map editing window shows the data domain - either the limits of the data, or 
the non-oriented rectangle, according to the radio button selected.  
 
The limits cannot be edited. They change if the content of the file changes, in particular through 
a purge or a file import.  
 
The limits of the data express the rectangle with no angle with the cardinal directions, and 
containing exactly the file data. This rectangle is defined by its extreme coordinates in X, Y and 
Z, its width, its height and its differential in elevation. 
 
The non-oriented rectangle expresses the rectangle based on the cardinal directions, and 
containing exactly the oriented domain of the data.  
 
If the angle of the domain is 0, the non-oriented rectangle and the data limits are the same.  
 
7.1.8. Other operations 

The attributes button is used to define the line (color and size) and the marker (color, size and 
period) used when selecting an entity in “Mapping” mode (see paragraph 6). The marker is 
automatically an empty square.  
 
The Refresh button at the bottom of the map editing window updates the plan view with the last 
operations done, without exiting the editing window and without saving the data file.  
 
The Layers button opens the layer editing window (see paragraph 7.2). 
 
The Save as button opens the Window file saving window to save the data file with a new 
name. To save directly the data file, the user will use the Save data option of the File menu. 
 
The Close button closes the editing window but does not save the data file. 
 

7.2. Layer editing 

The Layer Editing option of the Modeling menu opens the layer editing window shown in figure 
2-6. The button shown here is equivalent. The window can also be opened via the Layers 
button of the map editing window. 
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This window shows the layers of cartographic elements contained in the data file (of 
cartographic, AutoCAD or point type (.sit, .ctr, .dxf, .xyz or .yxz)). These layers are generally 
present in AutoCAD .dxf files that can be opened with SM2. Remember that a layer can also be 
created during the creation of a series of points, a polyline or a polygon.  
 
The field Number of layers shows the number of layers in the data file.  
 

 

Figure 2-6 - Layer editing window 
 
The table at the bottom of the window shows all the layers present in the data file. The content 
of the cells of the Visible, Active and Delete columns can be changed by double-clicking in the 
cell itself, or on the column’s header to change the value for all the cells of the column. 

• The name of the layer; it cannot be modified. 

• The Visible column is used to display or hide a layer. By default, all the layers are Visible, 
with Yes in their cell.  

• When a layer is active, the user can select its elements. By default, all the layers are 
Active, with Yes in their cell. A layer can be visible and inactive. 

• Deleting a layer means deleting all the cartographic elements associated to that layer. To 
do this, put Yes in the Delete cell of the layer you wish to delete. The deletion is only saved 
when the Save button is clicked. Otherwise, the user can reshow the deleted layer by 
putting No in its cell.  

If the box Delete entities only is checked, all the elements of a layer will be deleted but the 
layer itself will be kept, with no elements (0). On the contrary, if the box Delete entities 
only is not checked, all the elements of the layer, as well as the layer itself, will be deleted. 

• The next column shows the Number of entities in each layer. These cells cannot be 
edited. 
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• The smoothing column is for future development. 
 
The attributes button at the bottom left of the layer editing window is labeled with the name of 
the current layer. The user can modify the drawing attributes for the selected layer, including the 
line and the marker for the polylines, the points and the contours of the polygons, and the filling 
for the polygons. The drawing attributes only affect the elements that belong to the layer and 
whose box Attribute by layer in their property window is checked. See paragraph 6.1.5. 
 
Clicking on the Redraw button updates the plan view with the last operations done on the 
layers, without exiting the editing window and without saving the data file. 
 
The Save as button opens the Window file saving window. The user can give a new name or 
save over the previous file.  
 
The Close button closes the editing window and updates the plan view with the last operations 
done on the layers but does not save the data file. 
 
The X button closes the editing window and applies no changes in the plan view. 
 

7.3. Recursive kriging 

Once the site is defined adequately, the user can create the site terrain model, commonly called 
DTM for “Data Terrain Model”. This model is a rectangular grid that covers the entire site and 
whose nodes have the terrain elevation. Conceptually, the constitution of a DTM is similar to 
placing a “net” on the site, consisting of rectangular meshes, and which moulds the terrain 
perfectly.  
 
Before calculating the DTM, the user must establish the equation described by the terrain 
surface inside the site using the points that have an elevation. The first method offered by SM2 
is the recursive kriging.  
 
The Recursive Kriging option of the Modeling menu opens the calculation by kriging window 
shown in figure 2-7. The button shown here is equivalent. 
 
In the Files used section: 

• The Point file shows the name of the file whose content is displayed in the plan view. This 
file is opened via the Open Data option of the File menu. A file can also be opened by 
clicking on the button at the extreme right of the Point file field. The selection of a file 
replaces the content of the plan view and updates the fields of the calculation window. The 
file must be of cartographic, AutoCAD or point type (.sit, .ctr, .dxf, .xyz or .yxz) for the 
calculation by kriging.  

• The directory of the current point file is indicated above. 

• By default, the K2D file shows the same file name, with the .k2d extension. The user can 
modify it by clicking on the button at the extreme right of the field which opens the file 
saving window.  

• The checkbox Replace existing file is used to overwrite an existing file, without a 
confirmation message being sent.  
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Figure 2-7 - Calculation by kriging 
 
In the Calculation parameters section: 

• The total number of points in the domain indicates the total number of points contained 
in the file domain. This information cannot be edited.  

• The minimum distance between points can be modified. If points are located at a 
distance less than this minimum distance, they will not be used in the calculation.  

The smaller the minimum distance, the more precision the result of the calculation by 
kriging will have. However, increasing the precision also increases the calculation time; the 
value 0 gives the maximum precision. SM2 calculates the value that presents the best ratio 
“precision vs calculation time” which is proposed by default.  

• The maximum distance between points can be modified. Points are then added to the 
line between two points located at a distance greater than the maximum distance, and the 
points are used in the calculation. SM2 proposes by default a maximum distance of 0, no 
adding any point.  

• The number of points used for kriging indicates the number of points with elevation that 
will be used in the kriging operation. This value changes with the minimum and maximum 
distances between the points.  

• The number of points per surface can be modified, with a maximum value of 500. This 
number is used to adjust the size of the kriging surfaces. The domain is divided in four 
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sections, then each can be re-divided in four until each section contains no more points 
than the maximum number of points indicated.  

• By selecting the option Show calculation progress, the progressive display of the 
calculation will be shown. The display sometimes stops, but the calculation is still being 
done.  

 
In the File domain section: 

• The type field indicates the type of file that will be created (K2DFILE). The version field 
indicates with which version of SM2 the file will be created.   

• The next fields define the domain of the file that will be created. The domain is a rectangle 
defined by the coordinates of its bottom left corner, by its width, its height, by the angle 
of its sides with the cardinal directions and by its elevation limits Z max and Z min. The 
user can modify the domain of the k2d file to be created, but not its elevation limits.  

• The reference system is not used. 
 

The attributes button is used to define a marker, its dimension and its color to identify the 
points that will be used in the calculation by kriging, when clicking on the Refresh button. 
 
The Refresh button updates the plan view and shows the points that will be used in the 
calculation by kriging.  
 

 

Figure 2-8 - Plan view during kriging 
 
The Calculate button starts the kriging. The calculation by kriging window reappears once the 
calculation is done. Figure 2-8 shows the display of the plan view during the kriging. The red 
points have already been kriged, the yellow points are being calculated, and the black points will 
then be calculated. 
 
The Close button closes the window. 
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7.4. Linear Triangulation 

As described at the beginning of paragraph 7.3, before calculating the DTM, the user must 
establish the equation described by the terrain surface inside the site using the points that have 
an elevation. The second method offered by SM2 is the linear triangulation.  
 
The Linear Triangulation option of the Modeling menu opens the calculation by triangulation 
window shown in figure 2-9. The button shown here is equivalent. 
 
In the Files used section: 

• The Point file shows the name of the file whose content is displayed in the plan view. This 
file is opened via the Open Data option of the File menu. A file can also be opened by 
clicking on the button at the extreme right of the Point file field. The selection of a file 
replaces the content of the plan view and updates the fields of the calculation window. The 
file must be of cartographic, AutoCAD or point type (.sit, .ctr, .dxf, .xyz or .yxz) for the 
calculation by triangulation.  

• The directory of the current point file is indicated above. 

• The limit file is for future development. 

• By default, the TIN file shows the same file name, with the .tin extension. The user can 
modify it by clicking on the button at the extreme right of the field which opens the file 
saving window.  

• The checkbox Replace existing file is used to overwrite an existing file, without a 
confirmation message being sent.  
 

In the Calculation parameters section: 

• The total number of points in the domain indicates the total number of points contained 
in the file domain. This information cannot be edited.  

• The minimum distance between points can be modified. If points are located at a 
distance less than this minimum distance, they will not be used in the calculation.  

The smaller the minimum distance, the more precision the result of the calculation by 
triangulation will have. However, increasing the precision also increases the calculation 
time; the value 0 gives the maximum precision. SM2 calculates the value that presents the 
best ratio “precision vs calculation time” which is proposed by default.  

• The maximum distance between points can be modified. Points are then added to the 
line between two points located at a distance greater than the maximum distance, and the 
points are used in the calculation. SM2 proposes by default a maximum distance of 0, no 
adding any point.  

• The number of points selected for triangulation indicates the number of points with 
elevation that will be used in the triangulation operation. This value changes with the 
minimum and maximum distances between the points.  

• By selecting the option Add points to cover the whole domain, a point will be added at 
each corner of the domain to be able to calculate the elevation of all the points. 
 

In the File domain section: 
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• The type field indicates the type of file that will be created (TINFILE). The version field 
indicates with which version of SM2 the file will be created.   

• The next fields define the domain of the file that will be created. The domain is a rectangle 
defined by the coordinates of its bottom left corner, by its width, its height, by the angle 
of its sides with the cardinal directions and by its elevation limits Z max and Z min. The 
user can modify the domain of the .tin file to be created, but not its elevation limits.  

• The reference system is not used.  
 

 

Figure 2-9 - Calculation by triangulation 
 
The attributes button is used to define a marker, its dimension and its color to identify the 
points that will be used in the calculation by triangulation, when clicking on the Refresh button. 
The line and filling attributes will be those used to show the result of the calculation by 
triangulation. 
 
The Refresh button updates the plan view and shows the points that will be used in the 
calculation by triangulation.  
 
The Calculate button starts the calculation by triangulation. Once the calculation is done, the 
display shows the result with the attributes defined. Figure 2-10 shows the display of the plan 
view before and after the triangulation. 
 
The Close button closes the window. 
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Figure 2-10 - Plan view before and after triangulation 
 

7.5. Data Terrain Model 

All the operations on terrain models (DTM for Data Terrain Model) are done from the operations 
on DTM window, opened via the Data Terrain Model option of the Modeling menu or the 
button shown here. 

 

Figure 2-11 - List of operations on the DTM 
 
The scrolling list associated to the Operation field is shown in figure 2-11. Each operation will 
be described in the following paragraphs.  
 
7.5.1. Calculate the DTM from a kriged file 

In the Files used section: 

• If a .k2d file was opened in the plan view via the option Open Data of the File menu, the 
operation Calculate the DTM from a kriged file will be automatically selected in the 
Operations on DTM window, as shown in figure 2-12. A file can also be opened by clicking 
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on the button at the extreme right of the Source file field. The selection of a file replaces 
the content of the plan view and updates the fields of the window. The file must be of .k2d 
type for this operation. 

• The directory of the source file is indicated above. 

• By default, the Resulting DTM shows the same file name, with the .dtm extension. The 
user can modify it by clicking on the button at the extreme right of the field, which opens the 
file saving window. The resulting files can be .dtm or .grd types.  

• The checkbox Replace existing file is used to overwrite an existing file, without a 
confirmation message being sent.  
 

 

Figure 2-12 - Calculate the DTM from a kriged file 
 
In the Calculation parameters section: 

• the user specifies the number of divisions in X and in Y for the DTM calculation. The 
number in parentheses is the size of a cell. The maximum number of divisions is 1000 by 
1000. 

• The display period represents the period of the grids displayed in the DTM created, in 2D 
or 3D, as well as during the calculation, if the box Show calculation progress is checked. 
For example, a period of 10 will show 1 of 10 limits, in both directions.  

 
In the File domain section: 
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• The type field indicates the type of file that will be created (DTMFILE). The version field 
indicates with which version of SM2 the file will be created.   

• The next fields define the domain of the file that will be created. The domain is a rectangle 
defined by the coordinates of its bottom left corner, by its width, its height, by the angle 
of its sides with the cardinal directions and by its elevation limits Z max and Z min. The 
user can modify the domain of the .dtm file to be created, but not its elevation limits.  

• The reference system is not used.  
 
The attributes button is used to define the color of the grids as well as a filling, used when the 
DTM is displayed in OpenGL mode and the option ”file color” is selected (see paragraph 7.8). 
 
The Refresh button updates the plan view. 
 
The Calculate button starts the calculation of the DTM from the kriged file.  
 
The Close button closes the window. 
 
7.5.2. Calculate the DTM from a triangulated file 

If a .tin file is opened in the plan view via the option Open Data of the File menu, the operation 
Calculate the DTM from a triangulated file will be automatically selected in the operations on 
DTM window. A file can also be opened by clicking on the button at the extreme right of the 
Source file field, which opens the Windows file selection window. The selection of a file 
replaces the content of the plan view and updates the fields of the window. The file must be of 
.tin type for this operation. 

 

Figure 2-13 - Example of a calculated DTM in 3D and in OpenGL mode 
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All the other fields have the same function as for the calculation of the DTM from a kriged file. 
See paragraph 7.5.1. Figure 2-13 shows the result of a calculated DTM in 3D view and in 
OpenGL mode with the selection of elevation color (see paragraph 7.8). 
 
7.5.3. Horizontal plane (domain S1) 

If a .dtm file is opened in the plan view via the option Open Data of the File menu, the last 
operation done on a DTM will be selected by default in the operations on DTM window. The 
operation can be modified via the scrolling list. 
 
With horizontal plane (domain S1), as shown in figure 2-14, a plane surface is created by 
giving the same elevation to each node of a grid. The domain of this plane is the same as the 
domain of the reference DTM, except the Z values. 
 

 

Figure 2-14 - Create a horizontal plane (domain S1) 
 
The Reference DTM is either the file opened in the plan view, or another can be opened by 
clicking on the button at the extreme right of the Reference DTM field. This file must be of .dtm 
or .grd type for this operation. The file domain is updated when a reference file is selected. 
 
The user then enters the horizontal plane elevation for all the nodes of the grid to create. 
 
In the Resulting DTM field, the user directly enters the name in the field or clicks on the button 
at the extreme right of the field to open the file saving window.  
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The file domain cannot be modified, since the grid of the new file must be the same as the grid 
of the reference file.  
 
The attributes button is used to define the color of the grids as well as a filling, used when the 
DTM is displayed in OpenGL mode and the option “file color” is selected (see paragraph 7.8). 
 
Click Calculate. The operation is done almost instantaneously.  
 
7.5.4. Add a constant (S1 + Z) 

With the addition of a constant (S1 + Z), as shown in figure 2-15, a grid parallel to the original 
grid is created. The nodes of the grid created keep the same coordinates as the original grid, 
but the elevation of each node is increased by a constant value.  
 

 

Figure 2-15 - Add a constant (S1 + Z) 
 
The Surface S1 is either the file opened in the plan view, or another can be opened by clicking 
on the button at the extreme right of surface S1 field. This file must be of .dtm or .grd type for 
this operation. The file domain is updated when a S1 reference file is selected. 
 
The user then enters the Z value to add.  
 
In the Resulting DTM field, the user directly enters the name in the field or clicks on the button 
at the extreme right of the field to open the file saving window.  
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The attributes button is used to define the color of the grids as well as a filling, used when the 
DTM is displayed in OpenGL mode and the option “file color” is selected (see paragraph 7.8). 
 
Click Calculate. The operation is done almost instantaneously.  
 
7.5.5. Subtract a constant (S1 - Z) 

The subtraction of a constant (S1 - Z) is exactly like the addition of a constant, except that the 
Z value is subtracted instead of added to the elevation of each point of the original grid. See 
paragraph 7.5.4.  
 
7.5.6. Add two surfaces (S1 + S2) 

The addition of two surfaces (S1 + S2) creates a surface by adding the elevation of each 
node from the first grid to the elevation of the corresponding node in the second grid. The 
domains and grids of the two files must be identical.  
 
The surface S1 is either the file opened in the plan view, or another can be opened by clicking 
on the button at the extreme right of surface S1 field. This file must be of .dtm or .grd type for 
this operation. The file domain is updated when a S1 file is selected. The surface S2 is selected 
the same way.  
 
In the Resulting DTM field, the user directly enters the name in the field or clicks on the button 
at the extreme right of the field to open the file saving window.  
 
The file domain cannot be modified, since the resulting file must have the same domain and 
grid as the S1 and S2 surfaces.  
 
The attributes button is used to define the color of the grids as well as a filling, used when the 
DTM is displayed in OpenGL mode and the option “file color” is selected (see paragraph 7.8). 
 
Click Calculate. The operation is done almost instantaneously. If the S1 and S2 surfaces don’t 
have the same domain or same grid, a message warns the user and the operation is not done.  
 
7.5.7. Subtract two surfaces (S1 - S2) 

The subtraction of two surfaces (S1 - S2) is exactly like the addition of two surfaces, except 
that it creates a surface by subtracting the elevation of each node from the second grid from the 
elevation of the corresponding node in the first grid. See paragraph 7.5.6.  
 
7.5.8. Upper surface (S1, S2) 

With upper surface (S1, S2), a surface is defined from the upper section of two grids. For each 
node, the highest elevation from the two surfaces is used for the new surface. The domains and 
grids of the two files must be identical.  
 
The surface S1 is either the file opened in the plan view, or another can be opened by clicking 
on the button at the extreme right of surface S1 field. This file must be of .dtm or .grd type for 
this operation. The file domain is updated when a S1 file is selected. The surface S2 is selected 
the same way.  
 
In the Resulting DTM field, the user directly enters the name in the field or clicks on the button 
at the extreme right of the field to open the file saving window.  
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The file domain cannot be modified, since the resulting file will have the same domain and grid 
as the S1 and S2 surfaces.  
 
The attributes button is used to define the color of the grids as well as a filling, used when the 
DTM is displayed in OpenGL mode and the option “file color” is selected (see paragraph 7.8). 
 
Click Calculate. The operation is done almost instantaneously. If the S1 and S2 surfaces don’t 
have the same domain or same grid, a message warns the user and the operation is not done.  
 
7.5.9. Lower surface (S1, S2) 

The lower surface (S1, S2) is exactly like the upper surface of S1 and S2, except that it creates 
a surface representing the bottom section of the two grids, by using for each node the lowest 
elevation from the two surfaces. See paragraph 7.5.8.  
 
7.5.10. Intersection of two surfaces (S1, S2) 

The intersection of two surfaces (S1, S2) calculates the intersection of two grids. The 
domains and grids of the two files must be identical. The result is a cartographic file with the .int 
extension. 
 
The surface S1 is either the file opened in the plan view, or another can be opened by clicking 
on the button at the extreme right of surface S1 field. This file must be of .dtm or .grd type for 
this operation. The file domain is updated when a S1 file is selected. The surface S2 is selected 
the same way.  
 
The Resulting file shows the same file name as S1, with the .int extension. The user can 
modify it directly in the field or by clicking on the button at the extreme right of the field to open 
the file saving window.  
 
The file domain cannot be modified, since the intersection file will have the same domain and 
grid as the S1 and S2 surfaces.  
 
The attributes button is not used. 
 
Click Calculate. The operation is done almost instantaneously. If the S1 and S2 surfaces don’t 
have the same domain or same grid, a message warns the user and the operation is not done.  
 
7.5.11. Calculate Z from a given surface (S1) 

The calculation of Z from a given surface (S1) calculates the elevation of the points 
constituting the elements of a cartographic file from a DTM.  
 
The Source file is either the file opened in the plan view, or another can be opened by clicking 
on the button at the extreme right of the Source file field, which opens the Windows file 
selection window.  This file must be of .sit type for this operation. The file domain is updated 
when a source file is selected. 
 
The Reference DTM is then selected the same way. This file is the reference for the elevations. 
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In the Resulting DTM field, the user directly enters the name in the field or clicks on the button 
at the extreme right of the field to open the file saving window. The extension is .sit. 
 
Click Calculate.  
 

7.6. Isovalue Contours 

SM2 can be used to calculate from a DTM grid the isovalue curves (contours), i.e. the lines of 
equal elevation. SM2 creates a .ctr extension file.   
 
The Isovalue Contours option of the Modeling menu opens the window for the calculation of 
isovalue curves, as shown in figure 2-16. The button shown here is equivalent. 
 
In the Files used section: 

• The DTM file field of the contours window shows the name of the file whose content is 
displayed in the plan view. This file is opened via the Open Data option of the File menu. A 
file can also be opened by clicking on the button at the extreme right of the DTM file field. 
The selection of a file replaces the content of the plan view and updates the fields of the 
calculation window. The file must be of .dtm or .grd type for this operation.  

• The directory of the current DTM file is indicated above. 

• By default, the CTR file field shows the same file name, with the .ctr extension. The user 
can modify it by clicking on the button at the extreme right of the field which opens the file 
saving window.  

• The checkbox Replace existing file is used to overwrite an existing file, without a 
confirmation message being sent.  
 

In the Calculation parameters section: 

• The distance between labels is the distance in geographic units (meters) between the 
labels showing the elevation of each isovalue curve, if the labels are displayed. If a curve is 
shorter than the distance between labels indicated, only one label will be displayed in the 
middle of the curve. 

• The contour interval for the intermediate curves is then indicated, in geographic units 
(meters). A curve will be displayed at each elevation interval indicated, from the minimum to 
the maximum elevation. A value is proposed by default, which takes into account the 
difference between the minimum and maximum elevations at the nodes of the DTM grid 
and the display dimensions. 

The attributes button right of the contour interval field is used to modify the drawing 
attributes of these intermediate curves. The line as well as the text can be modified. Note 
that the height of the text is in geographic units (meters).  

The Labels checkbox is used to display or not the labels of these intermediate curves.  

• The master contour interval is then indicated, in geographic units (meters). A curve will be 
displayed at each elevation interval indicated, from the minimum to the maximum elevation. 
A value is proposed by default, which is 5 times the value of the contour interval for the 
intermediate curves.  

The attributes button has the same role as for the intermediate curves.  

The Labels checkbox is used to display or not the labels of the master curves.  
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• The values of the minimum and maximum levels of the DTM file covering the difference in 
elevation and taking into account the interval between the intermediate curves are 
displayed in the inactive fields. The user can change the minimum and maximum levels 
to use in the calculation.  

If the values entered are outside the minimum and maximum elevations of the nodes of the 
grid, it is the values proposed that will be used in the calculation.  

• In additional contours, the user can add the elevation of the curves to add in the 
calculation of the isovalue curves.  

The attributes button right of additional contours is used to define the drawing attributes of 
the additional curves at a specified elevation.  

• By selection the option Show calculation progress, the progressive display of the 
calculation will be shown.  

• The file domain cannot be modified. It will be the same as the DTM file. 
 

 

Figure 2-16 - Window for the calculation of contour lines 
 
The Calculate button starts the calculation of the isovalue contours. The file produced is a 
cartographic file of .ctr type where the CTR_PRI layer groups the master curves, the CTR_SEC 
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layer groups the intermediate curves, and the CTR_USR the additional curves. Figure 2-17 
shows an example of a contours file in 3D.  
 
The Refresh button updates the plan view.  The Close button closes the window. 

 

Figure 2-17 - Example of an isovalue contours file in 3D 
 

7.7. Volumes 

SM2 is used to calculate the volume between two surfaces, as well as the volume between a 
surface and planes of constant elevation. The calculated volumes are saved in a .vol text file.  
 
The Volumes option of the Modeling menu opens the window for the calculation of volumes. 
The button shown here is equivalent. The two types of calculation are described below. 
 
7.7.1. Volumes between two surfaces 

The calculation of volumes between two surfaces determines the positive and negative 
volumes between two surfaces. The volume is positive where the first selected surface has an 
elevation greater than the one of the second surface; the volume is said to be negative in the 
opposite case.  

• The surface S1 is either the file opened in the plan view, or another can be opened by 
clicking on the button at the extreme right of surface S1 field. This file must be a data 
terrain model (.dtm, .ftm, .xtm) or a grid (.grd) for this operation. The directory of the 
source file is indicated above. 

• The surface S2 is selected the same way as the surface S1. 

• The limit of the domain for the volume calculation is not restricted and can be defined by a 
polygon. The limits of the domain in which we want to calculate the volumes are contained 
in a .lim file. If no .lim file is selected, the program calculates the volumes over the entire 
domain of the selected surfaces.  

If desired, select the polygonal limit. The .lim limits file can contain one or several 
polygons. If it contains several polygons, the first one defined will be the only one used in 
the volume calculation.  
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The polygon used can be partially or entirely outside the domain of the DTMs. If the 
polygon used from the limits file is completely outside the domain of the DTMs, the resulting 
volumes will be zero. If the polygon is partially outside the domain of the DTMs, the 
calculation will be done by taking into consideration only the portion of the polygon that is 
inside the domain of the DTMs.  

• By default, the Result file field shows the same file name as S1, with the .vol extension. 
The user can modify it by clicking on the button at the extreme right of the field which opens 
the file saving window. The result files are of text type, the .vol extension being generally 
used to indicate the volume reports.  

• The checkbox Replace existing file is used to overwrite an existing file, without a 
confirmation message being sent.  
 

 

Figure 2-18 - Calculation of volumes between two surfaces 
 
The calculation parameters and file domain have no effect for this type of calculation. They 
show the minimum and maximum elevations of the S1 file, as well as the domain of the S1 file. 



 SM2 - Site Mapping and Modeling 2-29 
 
 

Modeling menu 2019-09-27 
 

 

 
The Calculate button starts the volume calculation. The positive and negative volumes are then 
displayed in the table at the bottom of the calculation window.  
 
The Report button opens the .vol results file. An example for the above calculation is displayed 
in figure 2-19. 
 

 

Figure 2-19 - Calculation report of volumes between two surfaces 
 
7.7.2. Volumes by elevations 

The calculation of volumes by elevations determines the positive and negative volumes 
between a surface and planes of constant elevation. The volume is positive where the selected 
surface has an elevation greater than the one of the plane; the volume is negative in the 
opposite case.  

• The surface S1 is either the file opened in the plan view, or another can be opened by 
clicking on the button at the extreme right of surface S1 field. This file must be a data 
terrain model (.dtm, .ftm, .xtm) or a grid (.grd) for this operation. The directory of the 
source file is indicated above. 

• The limit of the domain for the volume calculation is not restricted and can be defined by a 
polygon. The limits of the domain in which we want to calculate the volumes are contained 
in a .lim file. If no .lim file is selected, the program calculates the volumes over the entire 
domain of the selected surface.  

Select the polygonal limit. The .lim limits file can contain one or several polygons. If it 
contains several polygons, the first one defined will be the only one used in the volume 
calculation.  

The polygon used can be partially or entirely outside the domain of the DTMs. If the 
polygon used from the limits file is completely outside the domain of the DTMs, the resulting 
volumes will be zero. If the polygon is partially outside the domain of the DTMs, the 
calculation will be done by taking into consideration only the portion of the polygon that is 
inside the domain of the DTMs.  
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• By default, the Result file field shows the same file name as S1, with the .vol extension. 
The user can modify it by clicking on the button at the extreme right of the field which opens 
the file saving window. The result files are of text type, the .vol extension being generally 
used to indicate the volume reports.  

• The checkbox Replace existing file is used to overwrite an existing file, without a 
confirmation message being sent.  
 

 

Figure 2-20 - Calculation of volumes by elevations 

• The calculation parameters show the minimum and maximum elevations of the S1 file 
according to the elevation interval. 

The user can modify the elevation intervals. The volume calculations will be done for each 
interval. 

The user can enter the minimum and maximum elevations of the planes for the volume 
calculations.  
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• The domain of the S1 file is displayed as information only.  
 
The Calculate button starts the volume calculation. The positive and negative volumes are then 
displayed in the table at the bottom of the calculation window, for all the elevations calculated 
from the maximum to the minimum elevation. 
 
The Report button opens the .vol results file. An example for the above calculation is displayed 
in figure 2-21. 
 

 

Figure 2-21 - Calculation report of volumes by elevations 
 

7.8. Color Selection 

The Color Selection option of the Modeling menu opens the color preferences window 
illustrated in figure 2-22.  The button shown here is equivalent. This option is active only when 
SM2 is in OpenGL mode. See paragraph 3. 
 
7.8.1. Color file 

The information in the color editing window is saved in a .clr color file. Before opening the color 
editing window, the user can change the current file by selecting a file in the Recent Colors 
option of the File menu.  
 
In the color editor, a colors file can be selected from the scrolling list associated to the top field. 
This list shows the last 9 colors files used. The user can also change the colors file by clicking 
on Browse, which opens the standard window for file selection on the directory of the current 
file. The proposed extension is .clr. 
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7.8.2. Color selection by elevation 

The left section of the window is used to define the colors for the different elevations, with up to 
10 elevations being defined. Each of the 10 color buttons opens a Windows color window 
where the user can select the desired color. The left bar shows the result of the color gradient. 
 
The field right of each color button indicates the elevation corresponding to the color defined. 
The checkbox right of each elevation indicates if the color for the corresponding elevation will 
be used or not for the data file. 
 

 

Figure 2-22 - Color Preferences window 
 
7.8.3. Application of colors 

The right section of the window is used to define the application of the colors by file type.  For 
DTM files (including the .dtm, .ftm, .xtm and .grd) and TIN files, the user has three choices. 
The MAP files are not used in the current version. 

• File Color will use the filling color of the data file. This color is defined when the data file is 
created.  

• Elevation Color will use the colors by elevation defined in the current color file. 

• User Color allows the user to define another color, by clicking on the button right of the 
label. 
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7.8.4. Other parameters 

In the On loading rectangle: 

• The user can decide to keep the elevation values, meaning that the value defined for 
each color does not change, even if the minimum and maximum elevations in the data file 
are different from the values indicated.  

With this option, the user will still be able to reload the elevations with actual domain 
data by clicking on the corresponding button. 

• With the option Set elevations proportional to domain, the elevations for each color are 
adjusted based on the elevations of the data file, to always use ten (10) values. 

 
When the Gradient Mapping option is selected, the color is displayed for the corresponding 
exact elevation, and a color gradient is added between the different elevations. If the Gradient 
Mapping option is not selected, the user can choose to extend colors:  

• Below elevation: The color is used for the surfaces whose corresponding elevation is 
indicated to its right, up to the next lower and active elevation. 

• Above elevation: The color is used for the surfaces whose corresponding elevation is 
indicated to its right, up to the next higher and active elevation.  
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